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1.Basic Concepts
1.1 Background

Building Information Modelling (BIM) is not just a three-dimensional drawing tool but a new
tool to holistically manage information relating to construction projects from planning stage, to
design, construction and operational stages. It is a new way of working using new technology
to facilitate project management and execution, better construction process control, cross-
disciplinary collaboration, internal coordination, external communication, problem solving,
decision making support, productivity management, and risk management.

A BIM project is made up of a lot of BIM objects such as walls, floors, columns, window, door,
furniture or even a picture on the wall. A BIM object should be contained geometry and non-
geometry information to achieve various requirement in whole life cycle of building.
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1.2 Purpose Driven

Drawing production is the most important and concerned deliverable of industry, both
statutorily and contractually due to drawing is the only accepted tool of submission and
communication in local practice nowadays. A value driven BIM should be able to generate
drawing production set for presentation, statutory and tender purpose.

3D Model

Statutory Drawings Contractual Drawings

(« =

—e CLTV CAMERA AT HL
CCTV CAMERA HOUSED IN WEATHERPROOF ENCLOSURE

L= i

e

o

55 OCTV CAMERA HOUSED N WEATHERFROOF ENCLOSURE
AT HL

[ELECTRO-MACNETIC DOOR LOCK

Local Practices . R e

24 FUSED CONNECTION UNIT

eg MEP Symbol 134 FUSED CONNECTON UNIT

2A WEATHERPROOF FUSED COMNECTION UNIT

Local Practices
e.g.ADM-9

E{W 134 WEAHTERPROOF FUSED CONNECTION UNIT
WP DENOTE WEATHE! e

\. - J/

To achieve drawing production purpose, the BIM object needs to be of the purpose and value
driven. A right quality BIM object should satisfy requirements which including suitable
geometry, non-geometry information, functional in BIM project and able to generate drawing
production.

The BIM object shall be designed and
modelled to enable to generate drawing
production without extra handling or
modifying. The value of BIM object is
created on its proper information including
geometry and non-geometry component.
Hence, the BIM object can coordination in
BIM model and generate schedule
production.

The minimum requirement of the BIM object
shall refer to “CIC Production of BIM Object
Guide - General Requirements” published
by Construction Industry Council. This
guide is standardizing all BIM object in
Hong Kong industry.
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1.3 Revit Sample Project

Revit has provided a set of Sample Revit Project of default installation including Architecture,

Structure and MEP models.

These sample projects are good start to learn Revit.

Each

discipline provided one basic sample and one advanced sample Revit project. You can open
these sample project from “File” -> “Open” drop down list -> “Sample Files” button.

Architecture

Structure

Systemns  Insert  Annotate

Analyz

(=]

MNew b

Open k

Save

Save As b

Export b

W @M T Y|

1 ‘;:"':I'J:i:utrfcflnw ]
% Publish ¥
@ Print b
I:a Close

Opens a Revit-compatible file.

I

$ 5 B L

Project
Opens a Revit project.

Family
Opens a Revit family,

Revit file
Opens any Revit file type.

Building Component
Opens a building component
Autodesk Exchange [AD5EK] file,

IFC
Opens an IFC file,

IFC Options
Sets options forthe IFC template and
class mapping.

sample Files

Opens a Revit sample file,

|Dptions |

| Exit Revit |




1.4 Revit Environment

In simple word, Revit models can separate to two kinds of file type, Revit Project File (.rvt) and
Revit Family File (.rfa). You can imagine that the Revit Project File is containing the building
while the Revit Family File is containing BIM Object.

Revit Project File (.rvt) /Revit Family File {.rfa}\

One Revit Project File is containing many Revit Family Files. Each Revit Family File is
containing one BIM Object and able to apply into many Revit Project Files. In other word,
relationship between Revit Project File and Revit Family File is similar of LEGO, Revit Family
File as like as little LEGO element and used to consist a large LEGO model (Revit Project
File).



1.5 BIM Object in Revit

BIM Obiject is called “Family” in Revit. A family is a group of elements with related graphical
representation and a common set of properties, called parameters.

There are 3 kinds of families in Revit: System Families, Loadable Families, and In-place
Families.

Most commonly used in projects are system families and loadable families. Loadable families
can be combined to create nested and shared families. Non-standard or custom elements
are created using in-place families in project environment and unable to be loaded into another
project.

System families contain family types for basic building elements such as walls, floors, ceilings,
and stairs in the building model. It also includes types for elements such as levels, grids,
sheets, viewports and project & system settings which affect the project environment. System
families are predefined and saved in templates and projects, not loaded from external files.
They can be duplicated and modified customized to become system family types.

Unlike system families, loadable families are created in external RFA files and imported into
projects. Most of building components, services components and 2D annotation BIM objects
are loadable families in Revit such as window, door, equipment and fixture, are loadable
families. Loadable families are the most extensive and customizable families in Revit.
Families can be customized for projects while a number of families are ready to use in the
Revit family library.

System Family Loadable Family
(.rfa)

* Wall * Door

* Floor * Window

* Stair Furniture

* Railing * Planting

* Pipe * Lighting

* Duct .




1.6 Introduction of Revit Project Ul

Revit Project Ul and Revit Family Editor Ul is similar with little difference. This section only
highlighted several important part which relative of Revit Family Application and drawing
production.

o Properties Window

When you select an element in Project, its Instance Parameter Information will show on this
properties window. Click the “Edit Type” button will show up a dialog which contain its family
type information (Type Parameter).

ZICMN  Architecture  Structure  Systemns  Insert  Annotate  Analyze  Massing & 5Site  Collaborate  View  Manage  Add-Ins

[ 2 T Cope - E}agj |DI:I & Dm D'ﬁ gooajm B - _ . [%} [C\C{Jj

Acut + = By~ ey .= -
= e Y %0335/ &F
& Join- Z& QT O L=

Select = QPropertiesy  Clipboard Geometry Madify View Measure Create

Modify

Properties x

M_Single-Flush
0915 x 2134mm

Doors (1) \I Edit Type I

Constraints 2oA
Level 01 - Entry Level
5ill Height 0.0 [

Construction >
Frame Type P

Materials and Finishes 2
Frame Material
Finish

Identity Data 'S
Hardware Group (none)

Image

Comments
Mark 1328

Phasing 'y
Phaze Created Mew Construction
Phaze Demolished Mone

Properties help Apply




e Project Browser

Shows a logical hierarchy for all views, schedules, sheets, groups, and other parts of the
current project / family.

Project Browser - rac_advanced_sample_project X

=0 Views [all) A
[=]-- Floor Plans
01 - Entry Level
01 - Entry Level - Furniture Layout
02 - Floor
03 - Fleor
Roof
Site
- Ceiling Plans
01 - Entry Lewvel
02 - Flocr
03 - Floor
Roof
= 30 Views
03 - Fleor Public - Day Rendering
03 - Floor Public - Might Rendering
Balcony View
Building Courtyard
From Parking Area
{30}
- Elevaticns (Building Elevation)
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o Visibility/Graphics Overrides

Used to control display which category, set display color / line weight / pattern override and
also allowed to set up filter by conditional. Notice that these setting only applied on current
view. If you want to re-use current setting, use “View Template”.

Properties x
Floor Plan -

Floor Plan: 01 - Entry Level v | 3 Edit Type
Graphics A oA
Wiew Scale 1:100

Scale Value 1: 100

Display Model Meormal

Detail Level Medium

Parts Visibility Show Original

Detail Mumber 1

Fotation on Sheet Mone

Graphic Display Options Edit...

Model Categories | Annotation Categaries I Analytical Model Categories I Imported Categaries I Filters |

Show model categories in this view If a category is unchecked, it will not be visible,

Visibility

Projection/Surface Cut

Patterns Transparency Patterns

Halftone

Air Terminals

Areas

Cable Tray Fittings
Cable Trays
Casework

Ceilings

Columns

Communication De...
Conduit Fittings
Conduits

Curtain Panels

Curtain Systems
Curtain Wall Mullions
Data Devices

Detail ltems

SIS SIS
1\0/0|o|o|o|ojo|o|ojo|o|o|o|o|o

Qwerride Host Layers
[[]cutLine Styles

All | | Maone | | Invert | | Expand All |

Categories that are not overridden are drawn -
according to Object Style settings. Object Styles...
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¢ View Range

When you state on a plan view, a property name “View Range” will show the property window.
This property is affecting what is the range showing on the plan.

Properties =

Floor Plan: 01 - Entry Level v| Edit Type

Show Hidden Lines By Discipline ~
Color Scheme Location Background
Color Scheme <none>
System Celor Schemes Edit...
Default Analysis Displa...:Mone
Sun Path 1
Underlay S
Range: Base Level Mone
Range: Top Level Unbounded
Underlay Orientation Look down
Extents S
Crop View |
Crop Region Visible ]

Floor Plan -

Primary Range

Learn more about view range

Top: |Assodated Level (01 -Entry | Offset:

Cut plane: Assodated Level (01 -Entr Offset:

Bottom: Associated Level (01 -Entr) v | Offset:
View Depth

Level: Uniimited v|  Offset:
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1.7 Family Library and Resource
o Autodesk Revit Product Library

Autodesk has provided a lot of family libraries can optional install when installing Revit.

- The default library is “US Imperial” where all families are created under imperial unit
and not suitable to use in Hong Kong industry.

- Optional library “US Metric” is used metric unit, thus, suggested to install and set to
default.

- If do not change the installing setting, the default path of library is:

C:\ProgramData\Autodesk\RVT xxxx\Libraries\ (where xxxx is installed Revit version)

e RevitCity (https://www.revitcity.com)

Open Source Revit content and online Revit community forum.

e bimobiject (http://bimobject.com)

International BIM content platform. Over 20 million products provided from manufacturer

13
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2.Fundamental Family Modelling
2.1 Create New Family

Create new family from “File” -> “New” -> Extended List —> “Family”

o Must open the extended list of “New” tab and click “Family” button to create new
family, otherwise the browser will show dialog of create new Revit project.

EHG-G->-8 2- 9 A 30 55

Architecture  Structure  Systems  Insert Annotate  Analyz

(}}'_j Creates a Revit file.

Mew E Project
Creates a Revit project file.

Open b Family

Creates a set of custom components
to use in projects.

Conceptual Mass
@ Opens a template for creating a

Save

conceptual massing model,

Save As k

Title Block
Opens a template for creating a Title
Elock family.

Export b

FEN- "0 s TR

Annotation Symbaol
lo Creates a tag or symbol to identify

— i i
Suite elements in the project.

Workflow F
5

S

Publish b

Print b

Close

o) 10 &

| Options | | Exit RE’H‘it|
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2.2 Introduction of Family Editor Ul

Revit Family Editor Ul is similar with Revit Project Ul. This section will only briefly introduce
the default Ul on family editor. Useful commands and shortcuts please refer to attachments.

i
) Snoets o)
e 80 Famiies
[ Groups
o Rt linke
Lo Bassan@e - omoldc] E
Egm.*n,mm- fternstcs, CTRL odds SHIFT unaclccts | B W )

¢ Quick Access Toolbar: The top bar, can customize by user;
¢ Ribbon: Provides all tools necessary to create a project or family.

O ‘D | (1 = s 1% [C‘{’ i LIl
L3 Hl Sy Po &P DI a8 By g ] Eo
Medify| | [HI| | O] Join » 85 - | Jty O3 == DoD \{/}‘ 7Y Load inte Load into
I:% N @f @ -0 *i.’ ) _|‘T =_g|| g_g‘l ® T B Project Project and Close
Select | Properties | Clipboard | Geomnetry | Modify | Measure | Create | Family Editor | |

e Properties Palette: Modeless dialog where you can Properties x
view and modify the parameters that define the

properties of elements. N
Family: Generic Models ~ Edit Type

Constraints H]
Host

Mechanical ]
Part Type Momal ]

Structural ®

Can host rebar ‘O

Dimensions E
Round Connector Dimen... : Use Diameter
Identity Data : E |

OmniClass Number
OmniClass Title H
Other A
Work Plane-Based

Always vertical

Cut with Voids When Loa..
Shared

Room Calculation Point

mimimiNim

Properties help Apply
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e Project Browser: Shows a logical hierarchy for all views, schedules, sheets, groups,
and other parts of the current project / family.

Project Browser - Family2 X

=0, Views [(all)
[=J- Floor Plans
Ref. Level
=~ Ceiling Plans
Ref. Level
= 30 Views
Wiew 1
{3D}
= Elevations (Elevation 1)
Back
Front
Left
Right
Sheets (all)
Or Families
[®] Groups
&2 Revit Links

¢ View Control Browser: Provides quick access to functions that affect the current
view

1:100 B G IR 7 8 g <

e Status Bar: Provides tips or hints on what to do. Other controls appear on the right
side.

Click to select, TAB for alternates, CTRL adds, SHIFT unselects. oL E[}‘; [j}; "}T} -0
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2.3 Family Category

All families can be classifying and grouping by “Category” such as Door and Window. Every
Family should be containing at least one “Type” or more. “Type” is used when building
components using similar geometry but little different on dimensions or non-geometry
information such as door sizes and model number.

Category

Family Family Family

g

Type Type Type

Category is the first definition to control the geometry how to display in the Revit Project of 3D
and 2D view. To display different line weights, line colors, line patterns, and material
assignments for different geometric components of the family (for example, the frame, sash,
mullions, and glass that comprise a window), the components can be assigned to
subcategories within the family category.

Categories are predefined in Revit software and cannot be created or changed by the user.
Subcategories are predefined in some families, but other subcategories can be created in
families as needed.

Basically, you should decide the family category before you create anything and select the
corresponding family template. However, if desired category family template has not been
provided or the category still not decided, you might want to change the category later. Noticed

that change category is seriously NOT suggested .
after many parameter and geometry has created. | ™m Cotegew end Foremeters ol |
| Family Category
Open “Family Category and Parameters” window Filter lists
under “Create” tab to change family category. :
Data Devices A
Doors
o Category is NOT allowed to change to Duct Accessories
. o Duct Fitti
some categories by system restriction. . Ectresl B ipment
e.g. A family created from 3D family = E_Tmca' Frdures
. ourage
template is not allowed to change to | Fire Alam Devices
H Fumiture
2D family category. Famiurs Systems
Generic Models
Lighting Devices
o -~ '
T A AT
Parameter Value "
Work Plane-Based ]
Always vertical
Cut with Voids When Lo [ ]
Can host rebar ™
. Part T N |
Select = Properties L P ke N
Conce
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2.4 Family Naming Conventions

A systematic naming convention is necessary of create, manage and apply a family library.
Refer to “CIC Production of BIM Object Guide - General Requirements”, Revit family has
suggested to apply Family Library Interchange Program (F.L.I.P.) naming conventions.

The abbreviation can make reference to F.L.I.P. Master Type List
(http://www.aiab.org/index.php/flip-quideline).

Format

<Category> - <Sub-Type> - <Originator> - <Descriptor 1> - <Descriptor 2>.<File Format
Extension>

Limitation on Number of Characters

e 3 characters for Category, Sub-Type and Originator field
e 25 characters for entire name including hyphen mark

Example
Field DOR-SGL-AEC-Wood- Description
w_Louver.xxx
Category DOR-SGL-AEC-Wood- A Door, DOR is the short form of the
w_Louver.xxx category / classification / catalog
“‘door”.
Sub-Type DOR-SGL-AEC-Wood- A Single Door, SGL is the short form
w_Louver.xxx of the sub-type “single”.
Originator DOR-SGL-AEC-Wood- AEC is the short form of the
w_Louver.xxx Architecture, Engineering and
Construction. It is to represent a
common standard of the industry.
This can be replaced by the name of
the creator in short form.
Descriptor 1 DOR-SGL-AEC-Wood- A door is made of Wood (Material).
w_Louver.xxx An optional descriptive text.
Descriptor 2 DOR-SGL-AEC-Wood- A door is built with Louver. This
w_Louver.xxx text further describes the BIM
object.
File Extension | DOR-SGL-AEC-Wood- File Format Extension
w_Louver.xxx

18
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2.5 Family Template

Autodesk Revit has provided basic family templates for the base of family creation. These
templates are classifying by category and several templates have provided build-in

parameter.
‘ Mew Family - Select Template File ? X
Look in: English v ¢ Bl ¥ E] vews v
= s . Preview
,f'\,\ X A | Mame Date rmodified Type (A
'-"j Annotations 01-Feb-18 442 PM  File folder
Conceptual Mass 01-Feb-18 4:40 PM  File folder
. Titleblocks 01-Feb-12 441 PM  File folder
H QMetric Baluster.rft 22-Jan-153 401 PM Autodesk F
Ql\-’letric Baluster-Panel.rft 22-Jan-15 401 PM Autodesk F
Qf\-’letric Baluster-Post.rft 22-Jan-15 401 PM Autodesk F
L\g QMetric Casework wall based.rft 22-Jan-15 401 PM Autodesk F
Eh’letric Casework.rft 22-Jan-15 401 PM Autodesk F
. EMetric Column.rft 22-Jan-15 401 PM Autodesk F
L:} [ Metric Curtain Panel Pattern Based.rft 22-Jan-15401PM  Autodesk F
5 [=3 Metric Curtain Wall Panel.rft 22-1an-15401PM  Autodesk
QMetric Data Device Hosted. rft 22-Jan-13 400 PM Autodesk F
L Ql\-’letric Data Device.rft 22-Jan-15 400 PM Autodesk F
= Qf\-’letric Data Panel.rft 22-Jan-15 400 PM Autodesk F
QMetric Detail ltem line based.rft 22-Jan-15 401 PM Autodesk F
] ) ’
File name: | | ~
v | Files of type: | Family Template Files (*.rft) hd
Tools - Open Cancel

Careful which template folder you are looking in, Revit default installation setting will be looking
to “English_I" folder and all templates are using imperial unit. Normally, Hong Kong industry
is using metric unit and metric templates are located as “English” folder.

o “Default path for family template files” browse location can modify as “Options” ->
“File Locations”
e The path of family template folder is:

C:\ProgramData\Autodesk\RVT xxxx\Family Templates (where xxxx is installed Revit version)
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2.6 Reference Plane and Work Plane

Unlike traditional drawing works on 2D software, lines and lines drawing over each other, Revit
is a 3D based software and must indicate “which face” you are drawing.

Reference plane is a basic component of all family creation. Several reference planes must
be provided by family template and you can draw additional reference plane if needed. The
work plane is indicating which reference plane using so only one reference plane can assign
to work plane in same time.

¢ In Revit Family Editor, each view has its own work plane setting.
¢ Everything drew on the reference plane will moving together if the reference plane
has movement.

Create reference plane by “Reference Plane” tool under “Create” tab.

T
1
1
1
&

Feferengk Reference
Line Plane
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2.7 Insertion Point

The insertion/origin point is the point at which you want to place the Family in a project.
Normally, the insertion point shall be located at center of the geometry on plan view (as
known as XY plane on three-dimension coordinate system) and bottom of the geometry on
elevation view (XZ plane or YZ plane). Following figure is indicated insertion point of simple
curb geometry by red lines.

Plan View Elevation View

-+ |

The insertion point can be located at other point if reasonable, e.g. lighting switch always
aligned on wall surface, the insertion point on plan view (XY plane) should be located at the
back side of the switch surface.

Each family template has created several reference planes and the intersection point of
these reference planes is the default insertion point of the family. Modify reference plane
property “Defines Origin” can modify the insertion point to additional reference plane.
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2.8 Create Solid and Void Geometry

Geometry is the basic component of 3D BIM object. Revit is able to create multiple solid and
void geometry to consist complex 3D shape. Both solid and void are using 5 forms: Extrusion,
Blend, Revolve, Sweep and Swept Blend. These commands are under “Create” tab.

2.8.1 Creating Extrusion
ReHIG-a--8 2-70A ©- 95

Create = Inse View  Manage Add-lns Mo
5 (1]

1 gl0@ @®

Modify| | [BI| |[ ][] | Extrusion|Blend Revolve Sweep Swept Void .
] (3 51 Blend Forms

Select +  Properties Forms

Shape for extrusion must be a closed loop without overlapping, otherwise Revit won’t allow us
to use Extrusion.

Autodesk Revit 2017

Error - cannot be ignored

Lines must be in dosed loops, The highlighted lines are open on one end.

Show More Info Expand ==

Quit sketching I Continue

]

Autodesk Revit 2017

Errar - cannot be ignored

Cannot have overlapping lines.

Show More Info Expand ==

Quit sketching Continue
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The Extrusions we’ve made are all starting from their work plane. Revit allow us to expand the
ends of Extrusion further.

With extruded geometry selected, adjust Extrusion End or Start. Notice Depth will be
calculated automatically.

Properties b4

R :

Eurniture (1) v| 63 Edit

ik [1) 5

Bdrusionbnd
Extrusion Start

A — S —
Visible = | ;

T
R e
Material  <ByCategory> 7
Identity Data A
Subcategory None

R e —.

Properties help Apply
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2.8.2 Creating Blend

Blend is essentially an Extrusion with two shapes. Go to Create tab, hit on Blend.

b

Modify

Select «

Properties

oW [

Void & !
Blend Forms

Forms

Instead of one shape, we have to sketch the bottom and the top.

Instinctively though our Top could situate on another work plane, it’'s imperative that you
draw both shapes on the same work plane. Otherwise it will raise many issues such as the
Depth will be calculated from the Top to somewhere upwards.

Complete Blend by clicking on the green tick mark.

Wiody
o | &
L Q% St~ § ‘E&DIQ D‘E '[DJ mﬂ QE
o oin - 8 - | o2, = 27 Loadinto  Loadinto
o EIER oy O S | ke
o] s || Grm || Gemem | [ [ T
Froperties 2| 2 oo pan: et Level - Fami2 (=)@ 5] | E320 View Vw1 Famiy2 (E=8 (IR T
‘ ~ > ~
R ‘ a $
[T S| 63 EditType Y -
Constrints 5 @
Host. it
[dentity ato p Y
OmniClass Number (B0 ] - L
General FUrniture and Spo. '
. * |
%]
0 I
0 |
|
Apply o O®HEeES < : > 10 BORERHGERED < >
| [ Efevation: Front - Famity2 oo | & eevation: Left - Famiy2 B E
a a
‘ L ‘ L
| : | :
\ \
| |
— — ey LN s
| \
10 O@®E2IES < 10 O@®E2IED <

Hold button and move mouse to Spin the View.

e e S S ]
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2.8.3 Creating Revolve

Go to Create tab, click on Revolve.

Create - - : :
{11153 =1 F==

3] HE] 0 Q@ ISGW |

Modify % Extrusion Blend) Revolve oweep Swept Void _
— Blend Forms

Select v | Properties | Forms |

Sketch a simple shape. Notice that just like Extrusion, Revolve doesn’t allow open loop either.

Error - cannot be ignored

Lines must be in dosed loops, The highlighted lines are open on one end.

Quit sketching Continue
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Draw Axis.

y IL Boundary Line ."[g

Mode

Draw

Al

Finish revolving.

—

Sowy BLMest =G &

Ty @B G O T Ha x| e st
Modify Farnily Editor

Properties | Clipboard Geometry Measure | Create

Properties

Floor Pla Ref Level - Famib2

seE=]

30 View View 1 - Farmiy2

s E=]

x
Famiy:Fumiture <] 68 edieype

dentity Data A
OmniClass Number  [F340.2000
OmniCiass Title General Furniture and Sp.

. ; A ——

Project Browser - Family2 x

T

m4,g<é@

Properties help R 12 O RHESED <

510 Views ()
- Floor Plans
Ref, Level
Ceiling Plans ‘
Ref. Level
3DViews
View 1 |
Elevations (Elevation 1)

o

o

[u

Front
Lot

Right

Sheets (all)
B Families.
@l Groups

2 RevitLinks

ey

120 OB®&EWHES <

Q” B
@}

B

120 EGRHGEVED < >

e

— R 77-“\";4&

12 DOO®EWESD < >

Click to select, TAB for alternates, CTRL adds, SHIFT unselects.

b= 0 N SR ]
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Properties x

R ;

Furniture (1) ) b= Edit Type

End Angle

2
Visible = .

Materials and Finishes | o
Material ~ <ByCategory> |
&

e | |

Properties help Apply

Visibilty/Graphics Over..| ____Edit. ]

Adjust End or Start Angle if you don’t want the shape to orbit a full circle.
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2.8.4 Creating Sweep

Sweep takes a sketch and moves it along the path. It's more flexible than Extrusion and Blend.

REEHG -7 -8 2-79A @[

File Create  Insert  Annotate  View Add-lns Mo

s | e 0 O G| &

Modify EI ;||_| Extrusion Blend Revolvel SweepfSwept  Void
5 Blend Forms

Select = Properties Forms

Select an existing path or draw a desirable path.

Profile:

Sweep

Notice a new plane is created for sketching the shape which is going to move along this path.
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Click on the green tick mark, exit sketch mode of the path. Click Edit Profile to sketch profile

of geometry.

X & &
v

Mode

Work Plane

Modify | Sweep > Edit Profile

E é ) Sketch Path %

Set  Show Viewer I‘:l?] -

Profile:
<By Sketch>

O (] Il &p o — . =N
D B Ml 222 =[x 22208 @ & @
Modify [T | I P | o8 O3 = ~ A M Show Viewer
Bl - o O] Taax | e L
Select v | Properties | Clipboard | _Geometry Modify Measure | Create | Mode Draw Work Plane
~ ChainOffset[ 00 DlRadivs: | 1000.0
e = [ Floor Plan: Ref. Level - Family2 S (& ][R | k) 30 View: View 1 - Family2 ERcEES
R Q hvd ]
BEERTS "
onstain 2 B @
v Level:Ref. Level
4 [
o] B
er... Edit... ]
<8y Category> ]
None
Soiid
Trjectory Segmentation 1]
Wiaximum Segrment An..| 35000°
Properties help TN 120 OO®mHEPIEDT < 1:20 EIHRHBRIEE < >
EE=]
g
B
v
Back
Front
Left FE — e
Right %
Sheets (all) 1
2] Families
¢
10 OG@AHPED < 1w OG@REDED <

B . B RS

Click on the green tick mark, exit sketch mode of the profile. Click on the green tick mark
again to finish the sweep editing.

gy B 8 8

=8

Family: Fumiture o] BB e

Constraints

3202000
eral Furnt

Frure and Sp.

0o

| Floor Plan: Ref. Level - Family2 EE=] 3D View: View 1 - Family2 E=R[EcH
‘ e ¥
B
\ - @
"
|
1o O&HWHEE < > 10 EGRHESED < >
| Elevation: Front - Family2 [SE )R] | ki Elevation: Left - Family2 = [@][=
G &
5 | 5
‘ L | »
\ |
10 OEREED < 12 DGR DIED <

Click to select, TAB for alternates, CTRL adds, SHIFT unselects.

oA O O e
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Pick a path is also an option.

FT

110 EIEHEES <

(i)

1:20 EABEHEESEDE <
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2.8.5 Creating Swept Blend

Swept Blend is the combination of Sweep and Blend. We're allowed to draw a path, starting

profile and ending profile.

ICreate Insert  Annotate  View  Manage  Add-Ins  Mc

2 00

fy| |[M] [[ ][] Extrusion Blend Revolve Swed

—_
— | | L—

Blend §Forms

w  Properties Forms

Simply draw an arc as our path.

|3} Floor Plan: Ref. Level - Family2 (o & |2 | | Egl 30 View: View 1 - Family2 [E=8EoR ("5
~ ~
) j
2l =)
= -
\ B -
\ - "
I | \
= —
\ I =~
— o [
I \
—~ ~ L= -
—~ J
v
1w OBmE»ES o > 110 FAHREHERED
~ ~
@) q)
- 1r - = -
Ly [}
| |
DU T -
v
v DO&EBERES < > 12 O@EM2RES <
== = B SR 2

Sometimes, the planes on which you want to draw your shapes are not assigned with a

perpendicular view.
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Viewer will help us in these cases.

[ 3D View: View 1 - Family2 o e

.
L5 Wenomee v s e poepe % >

= [l Elevation: Left - EH i
| % Q@
| : -

@ < :

Set  ShowlViewer
Work Plane e DE&EPIES < K

T oA O O

After draw the two profiles on corresponding plane, click the green tick to finish the swept
blend.

[l Floor Plars: Ref. Level - Family2 EErE=] 3D View: View 1 - Family2 = =]
I ~ ~
=
& ]
LY
- (@G
| L_‘Q
| v M
10 O @ES < > 10 EAHEHRSEDE < >
Elevation: Front - Family2 [E@ =] | R Elevation: Left - Family2 [ E]r=]
~ ~
@ G
= |
‘ L} N
\ ‘
v v
10 O @ES < > 1 O & @EE « >

e o R V]
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2.8.6 Using Void Forms

Void forms would be very handy when we want subtle modification. Revit has five void shapes
allowed to model which exactly same of the five solid forms command.

Create  Insert  Annotate  View  Manage Add-lns  Moc

| e EL 9 O G © W

Maodify| ||| | | Extrusion Blend Revolve Sweep Swept§] Void _
i I S Blendl Forms

Select = Properties Forms

If we want to smooth sharp edges:

[ 3D View: View 1 - Family2 [o][= =
o (]
6]
@
&2
W
1::0 FEIEHEBES < >
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Create a void cylinder.

Medify| | (Bl
iy

]

—E3

Properties

Select = ‘ Properties

—tH

0 0&aywO I\ &g

Bxtrusion Blend Revolve Sweep Swept| Woid | Model Compor

Forms

R

Family: Furniture

Constraints
Host

w | Edit Type

Tl Moo

Blend | Forms | Line

Woid Extrusion

m Yoid Blend
EEE Void Revolve
I

@ Void Sweep
@5 Void Swept Blend
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Notice that if not selected, the void will disappear. But what we want is the fact that its
existence will cut off our solid geometry.
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2.9 Concept of Material

In Revit, materials are used to control how elements display in views and rendered images.
Materials are allowed you to specify graphical, appearance, thermal, physical. Materials
storage independent in each project and family, called “Project Material”, until load into project
/ family. Notice that materials are name sensitive and family material will be overwritten by
project material which have same name.

¢ You can create your own material library for future use.
e “Graphics” tab define the material shading color and pattern on 2D view.
o “Appearance” tab define the material rendering texture.

Open Material Browser to manage Project Material.

',|@Ec;av<nvu:>v =80 A G- FE GBS

Create  Insert  Annotate  View || Manage || Add-Ins  Revit Express Tools  Fuzor Plugin @ Modify

@@L Nm £ % 0O B

Medify|§ Materials gf3bject Snaps Project  Shared Transfer Purge MEP _ Additional |
Styles Units Parameters Project Standards Unused Settings Settings
Select = Settings
Material Browser - Default ? x

|| O“ Identity [Graph\cs] Appearance

Project Materials: All v I EIEE «| v Shading
Name /—'- - Use Render Appearance
. o / (Sl RGB 127 127127
Transparency 0
. Default Light Source / v Surface Pattern
. Default Roof / Pattern <mone>
Default Wall
- Alignment  Texture Alignment. ..
-
~| ¥ Cut Pattern
# v Autodesk Materials ¥ Bi=- Pattern <none>
P Home Name -8 R
|
- Zinc -
. Wood Shake
i Woed Flosring
. Wood (Oak)
i Wood
-
T
i Vinyl Sheet Flooring
i Vinyl Compesition Tile .
- @- 85 «

Cancel Apply

Revit has provided a comprehensive material library. Open library panel by button shown on
above image.
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2.10 Assign Material

Select element and click the field named “Material”, a little button will appear on the field.

Properties X

< By Category>|

samns”

_______

-
£

Other (1) ~ | £ Edit Type

Constraints H]

Extrusion End 1000.0

Extrusion Start 0.0

‘Work Plane Level: Ref, Level

Graphics 2

Visible ‘™ [
1

Visibility/Graphics Overr... | Edit.... [
Materials and Finishes

Material <By Categorys|
Identity Data

Subcategory {None
Solid/Void {Solid

Properties help Apply

Project Browser - Family2 x
=] :D: Miews (all)
=-- Fleor Plans
L Ref, Level
= Ceiling Plans
: L. Ref, Level
3. 3D Views
... {3D}

Material Browser - Default

Q] | identiy [ Appearance | Physical | Thermal

? X

Project Materials: All v

(|
v il

Yellow Pine - Selid Natural Low Gloss

Name

. fefautt

. Default Light Source
. Default Roof
. Default Wall
. Glass

e

# v ) Autodesk Materials +

& stain

o
« [ii

PHome 000 Name

. Zine

. ‘Wood Shake
. Wood Flooring
. Wood (0ak)

A Woods & Plastics Finish Carpentry.Wood.Pine,|

Finish [Satin Vamish

Used For [Furmiture

» [ | Relief Pattern
» [] Tint

! o

-
. ‘Walnut

. Vinyl Sheet Flooring
. Vinyl Composition Tile

B
.@
n

«

oo [

Select desired material from Project Material or Material Library on pop up Material Browser.
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Click OK to assign material.

Properties X

Family: Generic Models
Constraints
Hast
Mechanical
Part Type MNormal E
Structural 3
Can host rebar |:| ]
Dimensions A
Round Connector Dime...éUse Diameter
Identity Data
OmniClass Number
OmniClass Title : i
Other kS
Work Plane-Based
Always vertical

Cut with Voids When L.
Charad

Properties help Apply

»

3

10RO

Project Browser - Family2 x
10, Views (all)

Floor Plans

. Ref, Level

Ceiling Plans

. Ref, Level

=1 Elevations (Elevation 1)

o Apply advanced material control by parameter.



2.11 Concept of Visibility Control

To achieve drawing production purpose, presentation requirement and reduce calculation
loading, we should control 2D and 3D element visibility.

Select element and click “Edit...” button on “Visibility/Graphics Overrides” property.

Graphics
Visible
Visibility/Graphics Overr.,

S

e T
Il e oo &
X e Padk NS 22 = ]
e m s
Sy @ B GO T aax S B
e e[y Vi e ot

on | Depm10000 ]
x

Family Element Visibility Settings X

Properties

View Spedific Display

) & Display in 30 views and:
Plan/RCP
Front/Back
Left/Right

When cut in Plan/RCP (if category permits)

Detail Levels
Coarse Medium Fine
Cancel Default Help

“View Specific Display” is controlling element visibility on 2D views. “Detail Levels” is
controlling element visibility on detail levels. Checked item represent the element will be
shown on that view setting.

¢ If you want to control 3D geometry visibility in 3D views, need to control “Visible”

property. However, if check out that, the element will disappear in the project
environment.

e Apply advanced visible control by parameter.
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2.12 Creation of Parameter

Parameters store and communicate information of all elements in a project. Parameters can
be customized for a project, and for any element or component category in the project.
Parameter is a big concept in entire Revit environment, thus, we focus parameter usage in
family first.

In family editor, all parameter of family is storage in “Family Types”.

=
@
@

by & by

Extrusion Blend Hevnlve Sweep Swept  Void _
Blend Forms

Select v | Properties | Forms .
| Parameter Properties L
Parameter Type I
(@) Family parameter
{Cannot appear in schedules or tags)
() Shared parameter
{Can be shared by multiple projects and families, exported to ODBC, and |
appear in schedules and tags) I
T : i b ]
e d B Select... Export...
Search parameters Q] I
Parameter Value Formula [ Lock | Parameter Data
Identity Data 2
Type Image = Name:
Keynote =
o E | | | ® Type
Manufacturer =
Type Comments Discipline:
URL =
Description - Comman w (O Instance
Assembly Code =
cost Type of Parameter: Reporting Parameter
Length cor (Can be used ko extract value
from a geometric condition and
Group parameter under: report it in a Formula or as a
. - schedulable parameter)
Dimensions w
Tooltip Description:
<MNo tooltip description. Edit this parameter to write a custom tooltip. Custom t...
Edit Tooltip...
7 ™t 1E 4E 4t Manage Lookup Tables
e = aory 5 = FEE

All family parameters belong either “Family Parameter” or “Shared Parameter”. Both are used
to descript information or control variable values of the family. The difference is Family
Parameter only “appear” inside of the family and cannot extract its information in Revit project.

Both Family Parameter and Shared Parameter can classify into two group, “Type Parameter”
and “Instance Parameter”. In Revit project, all element belong this family type will be affected
by Type Parameter. Instance Parameter can be customized of each element without affect
other.
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Item of Parameter Data

Description

Name
Discipline
Type of Parameter

Group Parameter
under:

Tooltip Description

Parameter name, must be unique. Case sensitive.

Revit default internal classification of parameter.

Indicate type of parameter such as Length, Material.

Indicate the parameter will be grouping under which group. Revit
has a lot of pre-defined group name and not allowed to custom.
This grouping function is suggested to use to primary

management of the parameter in the family.

Additional description of parameter, will appear when cursor stay
on that parameter. Can use to explain the parameter usage.
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2.13 Associate Parameter

Parameter is allowed user change family in the project without additional modify the family file.
These parameter called “Associate Parameter”. It also allows many elements share same
parameter, thus, one parameter can control many elements behaviors. For example, use
associate parameter to control family geometry, material or visibility.

e Assign Associate Parameter to Family Geometry

Create length parameter and input desired length.

Parameter Type
(@) Family parameter
(Cannot appear in schedules or tags)

(") Shared parameter

(Can be shared by multiple projects and families, exported to ODBC, and
appear in schedules and tags)

Export...

Parameter Data
Mame:
|Extrusinr1 Depth| (@) Type

Discipline:
Common [:] Instance

Type of parameter: Reporting Parameter

(Can be used to extract value
From a geometric condition and
Group parameter under; report it in a Formula or as a
schedulable parameter)

Length

Dimensions

Tooltip description:
<Mo tooltip description. Edit this parameter to write a custom tooltip, Custom t...

Edit Toaoltip...

How do I create family parameters?
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Assign the associate parameter to the element property by the gray button.

Properties x

R Family parameter: Extrusion End

Parameter type: Length

|Gen-.=_n'c Models (1) v | Edit Type Existing family parameters of compatible type:
= R |Sead1 parameters
Constraints A
Extrusion End 250.0
Extrusion Start 0.0
Work Plane Reference Plane: a
Graphics &
Visible i
Visibility/Graphics Overr...| Edit...
Materials and Finishes A
Material < By Category= EE
Identity Data ]
Subcategory < Mone=
Solid/Void Solid

]

How do I associate family parameters?

o After assigned the associate parameter, the element property will become gray and
disable to manual modify. Also an equal mark will appear on the button.

Properties x
Generic Models (1) v | FE Edit Type
Extrusion End {B00.0 |
Extruzion Start 0.0
Work Plane EF{eference Plane: a
Graphics ]
Visible EE
Visibility/Graphics Overr...| Edit...
Materials and Finishes >
Material «By Category> EE
Identity Data ]
Subcategory “<Mone> 5
Solid/Void Solid
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2.14 Model Line and Symbolic Line

To achieve drawing production purpose, many family shall be displaying symbol on 2D view.
Several ways can use to create symbol and the simplest way is just drawing lines on the family.

Family editor has two types of line, model line and symbolic line, creating by different
command.

e Model Line is a 3D element. Thus, it will be displaying on all 3D and 2D views.

e Symbolic Line is a 2D element. Thus, it will be only displaying on the 2D views which
parallel with the symbolic line.

Model Line under “Create” tab.

Create

b E D OmIRAIYE AL @ F

Modify| | B |[] Extrusion Blend Revolve Sweep Swept Veoid QModefl Compeonent Model Model | Control
gy Blend Forms J Line Text Group '
Select * | Properties | Forms Model | Control |

Symbolic Line under “Annotate” tab.

| ARO[ 1] [ &8 15

Madify| Aligned Angular Radial Diameter  Arc i Detail Detail | Symbol Masking
Length i Component  Group Regicn
Select « | Dimension = Dretail |
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3.Advanced Family Modelling

3.1 Introduction of Parametric Modelling

Applying parametric modelling into creation of BIM object allow the family to vary its size and
shape without creating new family. A well designed parametric family is able to apply in
various project and different purpose, however, parametric modelling would increase risk of
unexpected error, difficulty of modification and decrease speed of computer calculation.

Parametric modelling is not only including various dimension but also including constrain
relationship between elements.

3.1.1 Parametric Relationship on Reference Planes

Many methods allowed to create parametric modeling. However, a not well designed
parametric relationship will very easy to appear unexpected error and difficulty of modification.
Basically, use reference planes as all parametric relationship base is better. Use “Align”,
“‘Dimension” tools to create relationship from geometries to reference planes.

3.1.2 Pin

Use “Pin” command to pin the element, usually reference planes, to make the element
unmodifiable and unmovable.

I ga ajol Tl «— [l i il
= -17= = B B
+ = o 020 | propagate | Loadinto  Load int
== TN pagate | Load into oad into
*inr+ O ||T = =2 \{j\ |l:| <@ Extents Project Project and Cl
Modify Measure | Create | Datum Family Editor
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3.1.3 Align

Use

‘Align” command to align two elements.

gio oV —

oo
_—_l-l oo E 1 —
_ - "u
9 i =2 % f :
| Modify | Measure | Create

Click the reference element. The reference element will be highlighted.
Click the element which want to move.

A “lock icon” will appear after aligned. Trigger the lock will create constrain
relationship to force that element align forever.
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3.1.4 Locked Dimension

The basic application of “Dimension” tool is measurement. Revit provides five dimension tools
to measure different type geometry. All dimension tools allowed to assign parametric
relationship but “Aligned” (distance of two parallel elements), “Angular” (angle between two
elements) and “Diameter” (diameter of circular element) are always used.

\2\ . Aligned

Measure Create

AW

Angular Radial Diameter

Dirmension

Arc
Length

Only a measurement dimension is not a parametric relationship. Trigger the lock icon of the
dimension to create parametric relationship to force the value of dimension become

unmodifiable.

lugin I Mod\fylP\ace Dimensions =

®
1
£

| Measure | Create | Dimension

= GRALS F B

Aligned| Angular Radial Diameter Arc | Load into Load into
Length | Project Project and Close

| Family Editor

00
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3.1.5 Equality Dimension

The “Dimension” is allowed to create a series of dimension between several elements. Trigger
the “EQ” icon appear of multiple dimension will create equality relationship to force those
elements equality with each other. Notice that equality dimension is already a type of constrain,
if trigger the lock icon will force the value of dimension unmodifiable.

[ Modity | Dimensions IS
=1 S A

" o Edit Loadinte  Load into
g|| iﬁ,l ® 0 € | Witness Lines | Project Project and Close
Measure | Create | Witness Lines Family Editor
| | |
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3.1.6 Label Dimension

Dimension can be assigned and controlled by one parameter. User can control the family
geometry in project by this parameter. Notice that only assign parameter to dimension is a
parametric relationship but not a type of constrain, that mean if the element has been modify,
the parameter will been change. Trigger lock icon to force the dimension unmodifiable.

O W O qu D| ge e U e— ([ it i
by EFQ% B[P € 7 & P ﬁmq“m ] L LR
. . - - O o—0 . . .
Medify| || (B[ | 01 Join - @D - + Oa ___|—'| oo - Edit Load into Lead into

.I —HH - By & . *i* @] “T 22 % |J':|<> Witness Lines | Project Project and Close

Select = ‘ Properties Clipboard ‘ Geometry Modify Measure | Create | Witness Lines Family Editor
Medify | Dimensions | [“]Leader Prefer Wall centerlines ~ I Label: Length1=200 ~ I:llnslance Parameter | Related Dimensions
Properties * |

L?near Dimension Style i Length ] = 200

Linear
Dimensions (1) ~ Edit Type
Graphics H
Leader ;
Baseline Offset... ) i
Text ®
Value :200.0
Other ]
Label Length 1 | |

| f |

Properties help Aoplv | |
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3.2 Introduction of Formula

Revit allows user apply formula to control and calculation of parameters. Use conditional

statements in formulas to incorporate information from parameters.
e Parameter names in formulas are case sensitive.

Input formula on “Family Types” window.

B Family Types

Mame:

Parameter | Value Formula

Materials and Finishes
Material 1 iWu:u:ud

Dimensions
Length 1 200.0

Other
Visible 1

Identity Data

3.2.1 Formula Syntax

Formula is must be following the syntax:

Arithmetic / = x Operators y x,y: Constant Number or Parameter
Conditional Operators:
+ Addition
- Subtraction
* Multiplication
/ Division
Mathematical | = Function (x) Function (): Revit build-in mathematical function
Function
Strings = “Text” Text should be enclosed by “”.
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3.2.2 Useful Formula

Mathematical Function:

e Circle: m = pi()
e Square Root = sqrt(x)
e Exponentiation = x "y

Round Function:

¢ Round to nearest whole number = round(x)
¢ Round to smaller number = rounddown(x)
¢ Round to larger number = roundup(x)

Notice that round function in Revit only able to handle no unit value, thus, if you want to
round off a unit value must modify the formula to:

Result = round(x / 1) * 1
Conditional Statements:

Parameter type (Yes/No) and result of conditional statements must be a Boolean data type —
a binary number. Binary Number only have two possible value: 0 and 1 (as known as FALSE
and TRUE in logic).

o If formula return FALSE, the (Yes/No) parameter become No (unchecked);
e [f formula return TRUE, the (Yes/No) parameter become Yes (checked).

Revit Supported Conditional Operators:

e Less than (return TRUE if x less than y): X<y

e Greater than (return TRUE if x greater than y): X>y

e Equal (return TRUE if x equal y): X=y

e Negation (return TRUE if x is FALSE, return FALSE if x is TRUE): NOT (x)

e Conjunction (return TRUE when all statements are TRUE): AND (x,y,z...)

¢ Disjunction (return TRUE when anyone statements are TRUE): OR(x,y,z...)

“IF” Conditional Syntax:

e |F (<condition>, <result-if-true>, <result-if-false>)

e.g.
Parameter Value Formula
Dimensions
Length JZZZ : if(Width = 300 mm, 300 mm, 900 mm) i
Width :EIDDD ::
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3.3 Nested Family

A building component might be large and complex and possible to separate to several parts.
In other words, a small component might be a part of many building components. For example,
a company produces many types of door but they only support one types of door handle. We
can just create one family of the door handle and “Nest” into door families.

¢ Revit does not have restricted the nested number but suggested do not nest over 2
levels.

e This method is suggested to insert 2D symbol to 3D family.

e The nested family will become a part of the host family and cannot select / schedule /
tag independently in project if the “Shared” property of nested family is unchecked.

o The nested family can select / schedule / tag in project if the “Shared” property of
nested family is checked.

Loadable Family (.rfa)
Door.rfa /Doar Handle.rfa\

Nest Into L

Louver.rfa

/_oad Into

Project...
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3.4 Family Behavior Parameter

Revit has several build-in parameters which depend on family category to control that category
behavior in project. There are some behavior parameters appear in most categories.

e Work Plane-Based: If checked, allow family place on a reference plane whatever the
reference plane is horizontal, vertical or even slope plane. Otherwise the family will
only allowed to place on “Level”.

e Always Vertical: If checked, the family has forced to vertical in project.

e Shared: It will not have any effect if the family directly inserted into project. Only
effect when the family nest into another family.

Control family behavior parameter on properties palette when not selected any element or
open “Family Category and Parameters” window under “Create” tab.

- Create  Insert  Annotate  View  Manage  Add-Ins  Revit Express Tools  FuzorPlugin Medify

Select = | Properties Forms | Model
B Family Category and Parameters >
. x i
Properties Family Category
Data Devices ”
Doors
Family: Generic Models ~ Duct Accessories
Constraints # Duct Fittings
Host Blectrical Equipment
; Electrical Fist
Mechanical # E:t rieal Fidures
ourage
Part Type iNormaI E Fire Alarm Devices
Structural A Fumiture
Can host rebar ‘0 Fumiture Systems
Dimensicns 2 Generic Models
Round Connector Dimen... iUse Diameter Lighting Devices v
Identity Data H ' '
Omn!CIass N.umber Family Parameters
OmniClass Title
her 3 Parameter Yalue "
Work Plane-Based | Work Plane-Based ]
Always vertical Always vertical
Cut with Voids When Loa... [ ] Cut with Voids When Lo [ |
Shared ] Can host rebar ]
Room Calculation Point ] Part Type Mormal v
Properties help Apply Cancel
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3.5 Create Family Type

Use family type to create variable types including geometry or non-geometry information. Only
parameter value is changeable between each family type. Family behavior parameter, formula
and geometry constrain (i.e. locked align, pin etc.) cannot change in family type.

Manage family types in “Family Types” window under “Create” tab.

EHG-R->- =2-7 0 A @O =

b | 2L 0 O @ W

Modify| | | Extrusion Blend Revolve Sweep Swept Void _
pary Blend Forms

Selectv| Properties | Forms ‘

Family Types
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3.6 Introduction of Shared Parameter

Shared parameters are parameter definitions that can be used in multiple families or projects.
Definitions are stored in a text file which is independent of any family file or Revit project, thus,
access to the text file is possible from different families or projects.

Shared parameters are saved in a text file that can be placed in a shared area on the office
network or server to allow common access. One Revit project can refer to only one shared
parameter file at a time. Notice that the shared parameter text file must be modifying in Revit
and NOT allowed modifying by manual.

¢ Manage Shared Parameter

Open “Edit Shared Parameters” under “Manage” tab. Create new Shared Parameter File.

File Create Insert  Annotate

%
N %
E

Modify| Materials Object Snaps Transfer

Styles ParametersfProject Stand

Select =

Shared parameter file:

Parameter group:

Parameters:

Parameters

Mew...
Properties...
Move...
Delete

Groups

MNew...
Rename...

Delete

Help
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Create new groups.

Edit Shared Parameters

Shared parameter file;
|C:Wsers‘lbim?_zg‘pesktop\TEST.b(t | | Browse... | | Create...

Parameter group:

| v]

Parameters:

Darameters

New...

Properties...
Move,..

Delete

Rename...

Delete

oK | | Cancel | | Help

Create new share parameter. The parameter data is same with the family parameter. Notice
that shared parameter is NOT allowed to modify after creation.

Edit Shared Parameters

Shared parameter file:

|C:Wsers‘bim?_zg\.[!esktop\TEST.b(t || Browse... || Create...

Parameter group:

| Door W |

Mame:

|Door Panel Height] Properties...

Discipline: Move...
|Common

Delete
Type of Parameter:
|Lengﬂ'1 Groups

Tooltip Description:
<Mo tooltip description. Edit this parameter to write a custom...

Edit Tooltip...

Rename...

Delete

Help
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e Assign Shared Parameter to Family File

Create new parameter from “Family Types” window and select to apply Shared Parameter.
Select desired Shared Parameter from your Shared Parameter List. Shared Parameter
already defined parameter data so those field will be grayed and not allowed to manual modify.

" L
|
| P eter Properties | Shared Parameters X
Parameter Type Choose a parameter group, and a parameter.
i () Family parameter
(Cannot appear in schedules or tags) Parameter group:
Other ~
@) Shared parameter
(Can be shared by multiple projects and families, exported to ODBC, and Parameters:
appear in schedules and tags) Arrow Rotation ~ Edit. .
Cover Level
Selact... Expart. .. Down Rolling Height
Height 2
Parameter Data Height of Strips
Name: Is Cover Embedded in Concrete
> Length 1
<Mo parameter selected > | (®) Type Length 2
o Length Frame
Discipline: Length Inside
() Instance Length Qutside
) Offset From Ground
Type of Parameter: Reporting Parameter Parking Length
(Can be used to extract value Parking Siripe Width
from a geometric condition and EIETPHIQ W'iﬂ" w
Group parameter under: report it in a formula or as & L Py
- - schedulable parameter’
Dimensions ~ Cancel Help
Tooltip Description:

<No toolkip description. Edit this parameter to write a custom toolbp, Custom k...

OK Cancel Help
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3.7 Annotation Family

2D annotation family is very important to achieve drawing production purpose. 2D symbol
used to represent the 3D geometry to industry acceptable drawing. 2D tag used to extract
information from family and shown on the drawing.

3.7.1 2D symbol

Beside of symbolic line, draw an independent 2D symbol family and nest into 3D family is
more suggested because 2D symbol usually use in many building components.

Two family templates can create 2D symbol family:

e Detail Item family template and Annotation family template both can create symbol.
However, symbols using Annotation family template are varied according to the view
annotation scale in Revit but cannot be assigned individually. Detail Item family is
used 1:1 scale and will not change by view annotation scale.

o Detail Item family will be a good starting point. However, text note cannot be
appeared in Detail Item family when loading into the project

The Detail Item family template is under same folder of family template library.

The Annotation Family Template is under “Annotation” Folder in the family template library. A
shortcut on the bottom of “New” drop down list can directly browse the annotation family
template folder.

Architecture  Structure  Systems  Insert  Annotate  Analyz

Egj E Creates a Revit file.

D g v [m Project

Creates a Revit project file.
E’ Open ]

Family
Creates a set of custom components
to usein projects.

E S Conceptual Mass
@ Opens a template for creating a
ﬁ Save As 4
Title Block
= Opens a template for creating a Title

conceptual massing model,
Elock family.
= Export 2

Annotation Symbol
l<> Creates a tag or symbol to identify
§ C—— elements in the project.
Suite
Workflow k
5
Tté Publish 3

@ Print 4
Close
8

| Options | | Exit Revit|
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When you creating a symbol for a family, the symbol must choose from 3 methods. The
simplest way is draw directly on the family by symbolic line. Another one is nest one
annotation family. The last one is nest one detail item family.

Whatever which method you used, the symbol must state inside the family. NO symbol will
draw / place individually in the Revit Project.

Revit Project File (.rvt) Loadable Family (.rfa)

@il Iltem Family(.rfa) \

Load Into N OraW lsymeoid
. Project... —
. Door.rfa J/
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3.7.2 Symbol Requirement
Based on “C/C Production of BIM Object Guide - General Requirements”, several requirement
has been indicated to satisfy drawing production.

o “The BIM object symbol shall be followed with the geometry” & “Symbol is orthogonal
to the BIM object geometry”

If the symbol is stated inside the family, it must fulfil this requirement.

e “Controllable offset(s) for overlapping object in the BIM model”

In reality, some type of building component might overlapping each other on plan and their
symbol still need to show as individually. For example, lighting switch and socket might be
occur this issue.

Plan View Elevation View —

~

1000
900
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To solve this isse, the family symbol must have controllable offset. There is a sample to
achieve this function by using a detail item family. The geometry is drew on the inserction
point but does not shon on this sample. Prepare two reference plane and named as image
shown. Pin the Ref_PIN reference plane and set the “Is reference” propertry to “Not a
reference”.

Reference Plane: Ref PIN Reference Plane: Symbol

N Detail Item Family(.rfa)

Default Reference Plane

Other
|= Reference ‘Mot a Reference

........................................................................ .:..:..:

-

Use “Align” tool to lock the symbol to the suitable reference plane. In this sample, vertical is
aligned to Symbol reference plane and horizontal is aligned to default reference plane.

Reference Plane: Ref PIN Reference Plane: Symbol

Detail Item Family(.rfa)

N

Default Reference Plane
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Make dimension between Ref_PIN and Symbol reference planes. Assign Instance Parameter
named Symbol Horizontal Offset to the dimension. Remember that the symbol place into
suitable place before using.

Reference Plane: Symbol
Reference Plane: Ref PIN (Overlapped)

mbal Horizontal Offset = 540
# &

N Detail Item Family(.rfa)

Default Reference Plane

Follow this method you should able to see a Shape Handle on the family after loaded into
Revit Project. That allow user easy to apply symbol offset if needed.
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e Family Place Higher Than Cut Plane

If the family need to show on the floor plan but it geometry placed higher than cut plane of
view range setting will make it does not shown on the plan. For example, an Exit Sign is place
on high level but it need to show on submission drawings.

Properties

Constraints

Lines (<Invisible lines>] (1)

Visibility/Graphics Overr..

Dimensians
Length

[ dentity Data
Subcategory

<lnvisible lines>

Other
Reference

Weak Reference

Model o Symbolic

Model Lines

Family Editor Project Elevation View
‘Z—Top Clip Plane
N R
o Cut Plane
- v
w1~ T
9000 N O
ﬁ
_ " — Level 1 w
Model line on reference level
The model line does not show in O
project because it is unvisible.
Properties x
Lines (<lnvisible lines=) (1) ~
Constraints ]
Work Plane Level : Ref. Level
Moves With Mearby Ele... {[]
Graphics 2
Visible O |
Visibility; Graphics Over... Eat. 71N
Dimensicns N
Length :900.0
Identity Data H
Subcategory <Invisible lines>
Other H
Reference ‘Weak Reference
Model ar Symbolic glﬂcclel Lines i

Project Elevation View

Top Clip Plane
IZ_ p Clip

Level 1

b 4

project becaus

e itis unvisible.

The model line does not show in 0
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o “The BIM object symbol shall be modelled, where appropriate, size-dependent with
3D geometry”

Whatever the symbol is drew by Symbolic Line or Annotation / Detail Family, it still can apply
parametric modelling. Use “Align” tools, label dimension and associate parameter skill to
achieve this requirement.

3.7.3 2D Tag

2D Tag is a separate BIM object (loadable family) in Revit environment. Similar with 3D family,
2D Tag family has many templates classified by category. 2D Tag family has following
characteristics:

e 2D Tag family templates are under annotation templates so 2D tag will be affected by
scale in Revit.

e The 2D tag family category should be match with the target category, e.g. if tagging
a door, the 2D tag family should be under “Door Tags” category.

o Allinformation (parameters) of 2D Tag family should extract from target in Revit
project. These parameters should be Shared Parameter.

3.7.4 Tag Creation

Tag family template is under “Annotation” Folder in the family template library. A shortcut on
the bottom of “New” drop down list can directly browse the annotation family template folder.

Architecture  Structure  Systems  Insert  Annotate  Analy:

clE

Creates a Revit file.

DNEW , E Project

Creates a Revit project file.

E Open b D Family
Creates a set of custom components

to use in projects,

E ST Conceptual Mass
@ Opens a template for creating a
conceptual massing model.
ﬁ Save As 3
Title Block
o Opens a template for creating a Title

Elock family,
=5 Export »

Annotation Symbal
lo Creates a tag or symbal to identify
—— elements in the project.

Suite
Workflow M
5

=5
Q Publish 3

@ Print 3
Close
a8
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As like as normal creation procedure, you should take suitable family template.

|‘_§

My Computer

My Metwork. ..

|

Favarites

Look in: | |, Annotations

vlﬁqxq Views -

MName ° Date modified Type a  FPrevew
i Metric Callout Head 2017/1/18 =< 04..,  Revit Famil
[=3 Metric Data Device Tag 20171718 F5F 04, Revit Famil
[ Metric Doar Tag 2017/1/18 T 04...  Revit Famil
[ Metric Electrical Device Tag 20171418 F5F 04...  Revit Famil
[m3 Metric Electrical Equipment Tag 2017/1/18 T 04...  Revwit Famil
[ Metric Elevation Mark Bady 2017118 FF 04, Revit Famil
[a] Metric Elevation Mark Painter 201771718 FF 04...  Revit Famil
3 Metric Fire Alarm Device Tag 2017/1/18 T 04...  Revwit Famil
[ Metric Generic Annatation 2017118 FF 04, Revit Famil
[m3 Metric Generic Tag 20171718 F5F 04, Revit Famil
Metl'ic Grid Head 2017/1/18 T 04...  Revit Famil
[ Metric Level Head 20171418 F5F 04...  Revit Famil
I3 Metric Multi-Category Tag 2017/1/18 T 04...  Revwit Famil
[ Metric Room Tag 2017/1/18 T 04...  Rewit Famil
[ Metric Section Head 2017/1/18 F=F 0d...  Revit Famil v
< >

File name: | Vl
Files of type: |FaminTeranate Files (=.rft) Vl

| open | cancel

A note will be shown on Generic Tag Family Template to remind you change the category if
necessary. Remember delete that note before using.

Note:

Use Properties|Family Categories and Parameters to set the tag's category.

Insertion point is at intersection of ref planes.

Delete this note before using.
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The creation tool is similar of “Annotation” tool in 3D family editor. The important tool of create
tag family is “Label” tool.

Create Insert  View Manage  Add-Ins Modify =~

NECIS N A #EEHSARCQCIAA Y “s

Modify [ Line Detail |~ Symbol Masking Filled  Aligned Angular Radial Diameter Arc || Label §Text Check  Find/
oy Y i 2 Group Region Region Length Spelling Replace
Select = Properties Detail Dimension = Text u

The label is used to extract parameter information from other family so the content will various
by family information variation. If you only used “Text” tool, the content will be a fixed text.

When you creating or editing a label element, you will see “Edit Label” dialog. The list of left
hand side is listed all build-in parameter under the category so you can easily to extract
information such as mark and type mark from the list. If you want to extract your own created

parameter, you must use Shared Parameter. Select the “Add Parameter” icon bottom of the
list.

Select parameters to add to the label. Parameters will be combined into a single label.

Enter sample values to represent this label in the family environment. []wrap between parameters anly

Category Parameters Label Parameters
Select available fields from:

Parameter Name Spaces Sample Value Suffix | Break

Generic Models

-
Assembly Description
Assembly Name
Comments

Cost

Description

Family Mame
IfcGUID
Manufacturer

Mark

Model

OmniClass Number
OmniClass Title

Tvoe Comments

b= H
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When adding parameter, you will see the dialog is different of other, Revit only allowed use
Shared Parameter to label.

Parameter Type
®) Shared parameter

(Can be shared by mulkiple projects and Families, exported to ODEC, and
appear in schedules and tags)

Parameter Data
Mame:

Mo parameter selected =

Discipline:

Type of Parameter:

You can select more than one parameter into one label element. Use Prefix and Suffix to build
suitable text structure. If checked Break parameter will shift following parameter into next line.

The Sample Value is only shown on the family editor and suitable value make modification
easier.

Select parameters to add to the label. Parameters will be combined into a single label.

Enter sample values to represent this label in the family environment. []wrap between parameters anly

Category Parameters Label Parameters
Select available fields from:

Parameter Mame Spaces Sample Value Suffix
Generic Models Type Mark 1

i i -

Azsembly Description
Azsembly Mame
Comments

Cost

Description

Family Name
IfeGUID
Manufacturer
Mark

Model

OmniClass Mumber
OmniClass Title
Type Comments
Tvoe IfcGUID

i = ]
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3.7.5 Tag Command in Revit Project

After the tag family has loaded into Project, it cannot place individually on the model and must
be host with one element.

Use “Tag by Category” command under “Annotate” tab in Revit Project.

Analyze  Massing & 5ite Collaborate View  Manage  Add-Ins  Modify (e

-0 ] ) - = v +ac

e o [NE B QR 8 AY GO

C Spot Spot Spot  Detail Region Component Revision Detail Insulation Text Check Find/ § Tagby

jth Elevation Coordinate Slope  Line T N Cloud  Group Spelling Replace| Category
Detail Text o —

Move the cursor to the family which want to tag, a preview of the tag will appear on the view.

/’T
(
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3.8 Flip Control

When the family is placed in a project, the flip arrow allows you to change the vertical or
horizontal orientation of the family.

Create Flip Control under “Create” tab.
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4.Workshop

4.1 Introduction of Import Geometry from Other Programs

Family editor allow import geometry from another 3D software. Supported external file types

are DWG, DXF, DGN, ACIS SAT and SketchUP files.

Notice that only geometry will be

imported into Revit and need to add non-geometry information and parametric relationship by

manual if needed.

Open import function by “Import CAD” tool under “Insert” tab.

Bl

|:.-'1.'. |
Import

o

|.\-.'_LI

My Computer
"-f-..“

l Impert CAD Formats

Look in: | material

v|ﬁqxqmewsv

Mame

L4

This folder is empty.

Files of type: |DWG Files (*.dwa)

File name: |

? X

DGM Files (*.dgn)

ACIS SAT Files (=.sat)

SketchUp Files (*.skp)

All Supported Files (*.dwg

Correct lines that are slightly off axis

70



Refer to “CIC Production of BIM Object Guide - General Requirements”, a standardized BIM
object should provide BIM object sheet. CIC will provide BIM object sheet template.

4.2 BIM Object Sheet

——{tiathadTiTaN= |
eI STt — vopeyorwy | H | LTXS
4 o berozfg Miouwisaz
uorrshpuRE sppayos gy | 19981/ I
) . + 7 Xm_f + EELINT LR e p——
mm ..“ \ H“—_.— mE __W wﬂ—x—”—m_ . ¥ .
Mw I__m 9B ASND! ._BM_EEE_ ol |
“uoponpoud buimeaq | [fpdoid i
- =

w._”_mEcww as

00E weudinbz Ljersedg WoL-EI-DIAV-SDAS
§379V43AITIA LI3r30 WIS N3AIMA 3NTVA /3S0dund m |
s W4 o4 R
N 200° v 019 el 133HS 193rE0 WiF -5
P —_—
s3I J[CAWLAS (1-Z JRjBwRled paieys 2L SISIBWRIR [y (SRS W 5ZIS Joy dnjas Ewn_awm_._mﬂ_am.ﬂﬂm i sioz .._:uz | ¥ lounog) AENpU| UOoNISUOY
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5.Attachment

5.1 Customize Shortcuts

Revit has created several default shortcuts and allow user to customize. Revit also support
the customized shortcuts export to an external file and import back to another pc or new
version Revit.

Customize shortcuts by “Keyboard Shortcuts” window under “User Interface” option panel.
Options X

Confge

Tools and analyses:

User Interface

Architecture tab and tools ~
Graphics Structure tab and tools
Structural analysis and tools
File Locations Systems tab: mechanical tools
Renderin Mechanical analysis tools
9 Systems tab: electrical tools
Check Spelling Blectrical analysis tools
Systems tab: piping tools
SteeringWheels Fiping analysis tocls
. Massing & Site tab and tools w
ViewCube
Active theme: | Li
Macras ctive theme: | Light ~
I Keyboard Shortcuts: Customize... I
Double-dick Options: Customize...
Tooltip assistance: | Mormal w
Enable Recent Files page at startup
Tab Switching Behavior
After dearing a selection or after exiting...
Project Environment: |Return to the previous tab s
Family Editor: | Stay on the Modify tab ~
[~ Display the contextual tab on selection
O Cancel Help
& Keyboard Shortcuts ? X
Search: |_ el
Filter: All v
Assignments:
Command Shortcuts Paths
Maodify MD Create »Select; Insert>Select; Ann...
Select links Create=Select; Insert>Select; Ann...
Select underlay elements Create»Select; Insert>Select; Ann...
Select pinned elements Create»Select; Insert>Select; Ann...
Select elements by face Create>Select; Insert>Select; Ann...
Drag elements on select... Create>Select; Insert>Select; Ann...
Type Properties Create»Properties; Modify>Prope...
Properties PP Create>Properties; View>Windo...
Ctrl+1
VP
Family Category and Par... Create » Properties; Modify>Prope...
Press new keys: g Assign = Remove
Import... | | Export... | oK | | Cancel
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5.2 Useful Default Shortcuts
Tile Window (WT)

Floor Plan: Ref. Level - Chapter 3 & 4 Table.rfa

1o O@% h@meme s aa <

1:20

Elevation: Front - Chapter 3 & 4 Table.rfa
‘ <
: ! :
o |
o e I I < U .
w
\ \ - o
| [ \
I Leg Inset = 100
LV v

O@% G o faf g«

evation: Right - Chapter 3 & 4 Table.ffa

3D View: View 1 - Chapter 3 8.4 Tablefa

[ - F R T

1w B LB E s ma @ E «

Zoom All (ZA)

Elevation: Front - Chapter 3 & 4 Table.rfa Floor Plan: Ref. Level - Chapter 3 & 4 Table.rfa
~
@
2
y
8= = — H -
g H
I = =
Rer Lewet
4@
v
1o OF% BB o e ld« 1:0 OF% LBRE o aa < >
[l Elevation: Right - Chapter 3 &4 Table.fa [l 3D View: View 1 - Chapter 3 & 4 Table.rfa ==
~
[ [ i
oL
I I E
Y
v v
>

1m OB LRED 6§ s

i

n B G@mBsEe s tsa GF
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Command Default Shortcut
Align AL
Dimension DI
Move MV
Copy CcO
Rotate RO
Trim/Extend to Corner TR
Reference Plane RP
Visibility/Graphics Overrides \AY%
Tag by Category TG
Thin Lines TL
Wireframe WF
Shaded SD
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